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Introduction

Mastercam’s Dynamic Motion toolpaths deliver powerful benefits that help you get 
the most out of any machine. 

These 2D and 3D high speed dynamic milling toolpaths utilize the entire flute length 
of their cutting tools to achieve great efficiency in milling. They are designed to maxi-
mize material removal while minimizing tool wear. 
Additional benefits you gain by using high speed dynamic milling toolpaths include:

 Tool burial avoidance
 Minimum heat buildup
 Better chip evacuation
 Extended tool life 

This tutorial introduces you to Mastercam's intelligent, application-specific, 2D and 3D 
high-speed dynamic milling toolpaths.

Tutorial Goals
 Learn the benefits and uses of the Dynamic toolpath types
 Create basic Dynamic toolpaths
 Create stock models
 Learn to use other Mastercam toolpath utilities
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Estimated time to complete this tutorial: 5 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
 The tutorials cannot be used with Mastercam Demo/Home Learning Edition 

(HLE). The Demo/HLE file format (emcam) is different from the Mastercam file 
format (mcam), and basic Mastercam functions, such as file conversions and 
posting, are unavailable.

 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills. 
We recommend that you complete them in order. 

 Additional files may accompany a tutorial. Unless the tutorial provides specific 
instructions on where to place these files, store them in a folder that can be 
accessed from the Mastercam workstation, either with the tutorial or in any 
location that you prefer.

 You will need an internet connection to view videos that are referenced in the 
tutorials. All videos can be found on our YouTube channel: 
www.youtube.com/user/MastercamTechDocs.

 All Mastercam tutorials require you to configure Mastercam to work in a 
default metric or English configuration. The tutorial provides instructions for 
loading the appropriate configuration file.

Dynamic Toolpaths
The following toolpaths use Dynamic Motion technology: 

 Dynamic Contour
 Face
 Dynamic Mill
 Peel Mill 
 Dynamic OptiRough

Each toolpath has various benefits that make them unique from each other and their 
standard counterparts. 
INTRODUCTION TO DYNAMIC MILLING
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Dynamic Contour
The Dynamic Contour toolpath creates a familiar contour operation using dynamic 
motion and specialized options found only in dynamic toolpaths. The dynamic motion 
prevents tool burial and binding in small radii corners. Additionally, you can specify 
how Mastercam machines any material left on the walls. 

Face
The Face toolpath, when the Style is set to Dynamic, quickly cleans stock from the top 
of a part and creates an even surface for future operations. You can base the toolpath 
on either chained geometry or on the current stock model. 

Dynamic Mill
The Dynamic Mill toolpath machines pockets, leftover material, standing bosses, or 
cores. By setting the Machining region strategy to Stay inside or From outside, you 
can create a pocket toolpath that utilizes dynamic motion or a facing operation that 
has island avoidance capabilities. 
INTRODUCTION TO DYNAMIC MILLING
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By selecting the Stay inside strategy, Dynamic Mill becomes a pocket toolpath that 
utilizes dynamic motion. You select a boundary, areas to avoid, and set tooling, param-
eters, entry method, and linking values to generate the toolpath. Material is removed 
from the inside to the outside in a highly efficient manner.

By selecting the From outside strategy, Dynamic Mill becomes a facing operation that 
has island avoidance capabilities. This movement creates a toolpath that is allowed to 
move outside the selected material and removes from the outside to the inside. 

By enabling Rest Material on the Stock page, the Dynamic Mill toolpath removes 
material left by previous operations using dynamic motion. The Dynamic Mill opera-
tion calculates how much material to remove based on previous operations or 
INTRODUCTION TO DYNAMIC MILLING
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previous roughing tools. Only unmachined areas are processed for a Dynamic Mill 
operation. 

Peel Mill
Peel Mill, with the Cutting strategy set to Dynamic Peel, allows for efficient milling 
between selected chains. It uses a dynamic style of motion with accelerated back feed 
moves when the tool is not engaged in material. For a single chain, you define the 
width of the cut. Otherwise, the width is defined by the area between two contours.

Dynamic OptiRough
The Dynamic OptiRough toolpath is currently the only 3D toolpath that uses 
Mastercam’s Dynamic Motion technology. It supports cutters capable of machining 
very large depths of cut. A single Dynamic OptiRough toolpath can cut material in two 
directions: on stepdowns (-Z) and stepups (+Z). This bi-directional cutting strategy 
removes the maximum amount of material with the minimum amount of stepdowns, 
significantly reducing cycle times. 
INTRODUCTION TO DYNAMIC MILLING
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Similar to Dynamic Mill, you can select From outside or Stay inside when machining. 
However, instead of selecting regions, you select drive surfaces, check surfaces, and 
containment boundaries. 

Dynamic Toolpath Selection
The Dynamic toolpaths, especially the Dynamic Mill toolpath, require a unique way of 
understanding chain selection. 
Dynamic Contour does not require a closed chain to calculate a toolpath. All geometry 
selected will be cut by the tool motion. Peel Mill requires at least one open chain and 
no closed chains. 
INTRODUCTION TO DYNAMIC MILLING
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Dynamic Mill allows you to have even more 
control over your chaining by allowing you to 
select multiple kinds of regions with one 
toolpath. The types of regions are listed 
below:

 Machining regions: Areas to be 
machined. 

 Avoidance regions: Areas to be 
avoided during machining. Multiple 
avoidance regions can be selected.

 Air regions: Areas that contain no 
material and allows the tool to travel 
through it when machining. 

 Containment regions: Areas where 
the tool cannot travel outside of. 

 Entry chain: Select where the tool 
enters the part.

If the machining regions are open chains, 
you can extend the open chain to stock with 
the Open chain extension to stock options. 
For more information, view Mastercam’s 
Help.
INTRODUCTION TO DYNAMIC MILLING
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Dynamic OptiRough uses a different type of selection method compared to the other 
Dynamic toolpaths, as it is the only 3D Dynamic toolpath. When creating a Dynamic 
OptiRough toolpath, you have the following selection options: 

 Faces and Bodies: Surfaces, solid faces, or solid bodies to be machined.
 Check surfaces: Surfaces, solid faces, or solid bodies that you want to avoid.
 Containment Boundary: One or more closed chains that limit tool motion.
 Points: Select the point near where the toolpath will start.

Dynamic Milling Parameters
Several parameter options separate the Dynamic operations from their standard coun-
terparts. These parameters are on the Cut Parameters, Entry Motion, and Contour Wall 
page. 

 Micro lifts
 Entry methods
 Entry feeds/speeds
 Contour wall
 Approach distance

Micro lift options allow the tool to rise above the floor of the part for the portion of 
the toolpath that is not removing material. Benefits of the micro lift include chip 
INTRODUCTION TO DYNAMIC MILLING
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clearing and avoiding excess tool heat. The feedrate is controllable for the back move 
as well.

Entry methods provide several ways to enter the material for a Dynamic Mill toolpath. 
Options range from a simple helix to a medial path with trochoidal motion to a 
selected open chain. Mastercam’s Help contains detailed information on each of the 
methods available.

Use Entry feeds and speeds to avoid placing too much load on the tool upon entry. 
Set a short dwell interval after entry to allow the spindle to reach the necessary speed 
before beginning material removal.

Contour wall parameters provide input for remaining stock and previous tool informa-
tion. The values entered help Mastercam to calculate the most efficient material 
removal strategy when machining part walls. 
INTRODUCTION TO DYNAMIC MILLING
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The Approach distance parameter allows you to add a specified absolute distance to 
the beginning of the toolpath’s first cut.

Dynamic toolpaths create highly efficient motion based on selected chains and 
surfaces. They are part of the 2D and 3D HST family of toolpaths with many similarities, 
but with the stated enhancements. The high speed toolpaths themselves are a leap 
ahead of the standard pocket, contour, and area roughing toolpaths.
Creating and reviewing the motion of dynamic toolpaths is the best way to learn 
about the benefits and uses. Continue on to Lesson 1 to learn about the Dynamic Mill 
toolpath.
INTRODUCTION TO DYNAMIC MILLING



LESSON 1
1The Dynamic Mill Toolpath

The Dynamic Mill toolpath machines pockets, open pocket shapes and standing cores, 
or material left from previous operations.
In this lesson, you will create two Dynamic Mill toolpaths. The first one will clear mate-
rial around the outside of the part. The second Dynamic Mill toolpath uses the 
previous one as a source operation for clearing out remaining material on the top of 
the part.

Lesson Goals
 Set up stock
 Create two Dynamic Mill toolpaths
 Preview region chains
 Verify the created toolpaths 

Exercise 1: Opening Mastercam
1 Start Mastercam using your 

preferred method:
 Double-click Mastercam’s 

desktop icon.
Or

 Launch Mastercam from the 
Windows Start menu.

2 Select the default metric configuration file:
a Click the File tab.
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b Choose Configuration from 
Mastercam’s Backstage View to 
open the System Configuration 
dialog box.

c Choose ...\mcamxm.config <Metric> from the Current drop-down list.

d Click OK.

Exercise 2: Set up the stock
In this exercise, you will set up stock that will be used for the first toolpath.

1 Open the part file, DynamicMill, provided with this tutorial.
2 Save the part as DynamicMill-xxx, replacing xxx with your initials.
3 On the Machine tab, select Mill, 

Default. 
INTRODUCTION TO DYNAMIC MILLING
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4 Select the Levels Manager, located in the same area as the Toolpaths 
Manager. If it is not displayed, select Levels on the View tab to toggle the 
display or by pressing [Alt+Z]. 

Before creating the stock shape, you will first create a level to place the stock 
geometry on. This is a good practice for when you have part files that have 
thousands of lines, arcs, solids, or surfaces and you need to keep things 
separate from each other. 

5 On the Levels Manager, select the 
Add a new level button. 
A new level is added to the list and is 
then set as the main level.

6 Double-click in the Name column of 
the level you have just created and 
rename it to Stock geometry.
This level will now be used to place 
the geometry created by the stock 
setup. 
INTRODUCTION TO DYNAMIC MILLING
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7 Select Stock setup in the Toolpaths 
Manager. 
The Machine Group Properties 
dialog box displays.

8 On the Stock Setup page, select 
Bounding box. 
The Bounding Box function panel 
displays. 
INTRODUCTION TO DYNAMIC MILLING
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9 Select the entire part, as shown below:

10 Press [Enter] or click End Selection to accept the selection.
INTRODUCTION TO DYNAMIC MILLING
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11 Set the following parameters:
 Shape to Rectangular. This 

shape is better suited for this 
part as opposed to using 
Cylindrical. 

 Z to 28.6. Sets the size of the 
box in the Z axis. 

 Under Create Geometry, 
select Lines and arcs. This will 
create lines and arcs based on 
the stock shape that can be 
used for many functions.

12 Click OK to accept and create the boundary, and return to the Machine Group 
Properties dialog box.
INTRODUCTION TO DYNAMIC MILLING
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13 Click OK in the Machine Group Properties dialog box. The part now displays 
with the stock boundary and geometry. 

You have now created the necessary stock and geometry to create the 
Dynamic Mill toolpaths.

14 Save your part. 

Exercise 3: Create the first Dynamic Mill toolpath
You now create the first Dynamic Mill toolpath to machine the outside of the part.

1 Select Dynamic Mill from the 2D Gallery on the Mill Toolpaths contextual 
tab.

The Enter new NC name dialog box displays. 
INTRODUCTION TO DYNAMIC MILLING
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2 Click OK. 
The Chain Options dialog box 
displays.

3 Click Select under Machining 
regions. 
The Chaining dialog box displays. 
Machining regions are the regions 
that are going to be machined.

4 Select C-plane in the Chaining 
dialog box.
This option allows you to chain only 
entities that are parallel to the 
current construction plane and at 
the same Z depth as the first entity 
you chain. 
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5 Select the chain shown below as the machining region:

By changing the chaining selection to C-plane, you avoid selecting each line 
individually.

6 Click OK in the Chaining dialog box to return to the Chain Options dialog box.
7 Set the Machining region strategy to 

From outside.
From outside uses free-flowing 
motion to machine features such as 
standing bosses or cores. This is the 
strategy you want to clear the 
outside of the part. 
INTRODUCTION TO DYNAMIC MILLING
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8 Click Select under Avoidance 
regions.
The Chaining dialog box displays.
Avoidance regions are regions that 
you want to avoid during machining. 
In this case, you want to avoid the 
part itself and clear out the area 
between the stock boundary and the 
part. To do this, you will need to 
activate another level. 

9 Select 3D in the Chaining dialog 
box. 
This mode chains entities defined in 
the X, Y, and Z axes simultaneously.

10 Select the Levels Manager. Move the Chaining dialog box out of the way if 
necessary. 

11 Click in the Visible column for the 
Part geometry level. 
This will display the geometry we 
need to select. 
The geometry is a silhouette of the 
part. This allows you to machine 
around the part and clear out the 
stock, but without cutting into the 
part.
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12 Select the chain shown below as an avoidance region: 

13 Click OK in the Chaining dialog box to accept the chain and return to the 
Chain Options dialog box.
Before you accept these chains in the Chain Options dialog box, you will first 
preview them to see if these are the chains you want.
INTRODUCTION TO DYNAMIC MILLING
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14 Right-click in the graphics window and set the view to Top (WCS). 

15 In the Chain Options dialog box, 
click Preview chains.

Your part then displays as shown below:
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Mastercam displays your material in the red and black crosshatch, the motion 
region as blue, and the tool containment as yellow. By using Preview chains, 
you can determine if that is what you want from the toolpath before even 
entering any parameters.
You can change these colors by selecting the Color button. These options are 
also available on the Toolpath Type page.

16 Once you are satisfied, right-click in the graphics window and select 
Isometric (WCS). 

17 Click OK in the Chain Options dialog box to accept these chains.
The 2D High Speed Toolpath - Dynamic Mill dialog box displays.

18 Select the Tool page.

19 Click the Select library tool button. 
The Tool Selection dialog box 
displays. 
INTRODUCTION TO DYNAMIC MILLING
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20 Select the Filter button.
The Tool List Filter dialog box 
displays.

21 Select None to remove all filters.
22 Select the Endmill3 Bull filter. This ensures that you are only selecting Bull 

Endmill tools.

23 Click OK in the Tool List Filter dialog box. 
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24 In the Tool Selection dialog box, select the END MILL WITH RADIUS - 20/
R1.0 tool.

25 Click OK in the Tool Selection dialog box to add the tool to the toolpath.
26 Select the Cut Parameters page.

27 Set the following parameters:
INTRODUCTION TO DYNAMIC MILLING
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 Approach distance to 9.5. This adds a specified distance to the 
beginning of the toolpath’s first cut. 

 Stepover to 50.0%. Sets the distance between cutting passes in the X 
and Y axes. 

 Min toolpath radius to 2.5%. Mastercam uses this radius in 
combination with the Micro lift distance and Back feedrate parameters 
to calculate 3D arc moves between cutting passes.

 % of tool diameter to 500.0. Mastercam will not create a retract move 
if the distance from the end of one pass to the start of the next pass is 
less than this distance. The tool to stay down and move directly 
between the passes at the feed rate. 

 Micro lift distance to 0.0. The distance the tool lifts off the part on 
back moves. 

 Back feedrate to 0.0. Controls the speed of the backfeed movement of 
the tool.

 Cut order optimization to None. The toolpath to start at the most 
recently machined material when cutting.

 Stock to leave on walls to 0.5. Leaves a defined amount of stock on 
the vertical drive geometry.

 Stock to leave on floors to 0.0. Leaves a defined amount of stock on 
horizontal drive geometry. 

28 Select the Entry Motion page.
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29 Set the following parameters:
 Helix radius to 0.0. Sets the 

radius of the entry helix.
 Z clearance to 0.0. Sets an 

extra height used in the 
ramping motion down from a 
top profile. 

 Plunge angle to 0.0. Sets the 
angle of descent for the entry 
move and determines the 
pitch.

This toolpath does not enter down 
into the stock, so you do not need to 
set any entry parameters.

30 Select the Linking Parameters 
page.
INTRODUCTION TO DYNAMIC MILLING



32  MASTERCAM 2017 / The Dynamic Mill Toolpath
31 Set the following parameters: 

 Deselect Retract. Sets the height that the tool moves up to before the 
next tool pass.

 Change Top of stock and Depth to Absolute. Mastercam measures 
absolute values from the origin 0,0,0.

32 Select the Depth button to return to 
the graphics window.
This determines the final machining 
depth and the lowest depth that the 
tool descends into the stock. In this 
case, the machining depth will be in 
the middle of the part because 
Dynamic Mill uses the entire tool to 
cut.
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33 Select the chain shown below:

You will then automatically return to the 2D High Speed Toolpath - Dynamic 
Mill dialog box. Your Depth should now be set at -20.32.

34 Click OK in the 2D High Speed Toolpath - Dynamic Mill dialog box to 
generate your toolpath. 
INTRODUCTION TO DYNAMIC MILLING
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35 The toolpath will display as shown below: 

36 Save your part.

Exercise 4: Create the second Dynamic Mill toolpath
You will now create a second Dynamic Mill toolpath using the Rest material option.

1 In the Toolpaths Manager with the 
Dynamic Mill toolpath selected, 
select Toggle display on selected 
operations.
This will hide the display of the first 
toolpath and keep your graphics 
view clean while you create another 
toolpath.
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2 Select Dynamic Mill from the 2D Gallery on the Mill Toolpaths contextual 
tab.

The Chain Options dialog box displays.
3 Click Select under Machining 

regions. 
The Chaining dialog box displays. 
INTRODUCTION TO DYNAMIC MILLING
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4 Select the geometry shown below as the machining region. Use the C-Plane 
button to select the entire chain. 

The selection is the same geometry used in the first Dynamic Mill toolpath.
5 Click OK in the Chaining dialog box to return to the Chain Options dialog box.
6 Ensure that the Machining region 

strategy is set to From outside.
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7 Click Select under Avoidance 
regions.
The Chaining dialog box displays. 

8 Select the chain shown below as an avoidance region. Set the chaining to 3D.

You may need to rotate the part to select the chain. 
9 Click OK in the Chaining dialog box to accept the chain and return to the 

Chain Options dialog box. 
10 Click OK in the Chain Options dialog box to accept these chains.

The 2D High Speed Toolpath - Dynamic Mill dialog box displays.
INTRODUCTION TO DYNAMIC MILLING



38  MASTERCAM 2017 / The Dynamic Mill Toolpath
11 Select the Tool page.

12 In the Tool List, select the tool that was used for the previous Dynamic Mill 
toolpath, which is END MILL WITH RADIUS - 20/R1.0.

13 Select the Stock page.

14 Select the Rest material checkbox.
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This enables the page and tells Mastercam to calculate the cutting passes 
based on the remaining stock.

15 Set the following parameters: 

 Set Compute remaining stock from to One other operation. This 
calculates the remaining stock from a single operation.

 In the Operation List, select the 2D High Speed (2D Dynamic Mill) 
toolpath. 

 Set Adjustments to remaining stock to Use as computed. This 
option makes no adjustments to the stock model.

16 Select the Cut Parameters page. 
INTRODUCTION TO DYNAMIC MILLING
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17 The parameters are the same as the previous operation’s, so ensure that your 
toolpath matches the parameters shown below:

18 Select the Entry Motion page. 
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19 The parameters are also the same as the previous operation’s, so ensure that 
your toolpath matches the parameters shown below:

20 Select the Linking Parameters 
page.
INTRODUCTION TO DYNAMIC MILLING
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21 Set the following parameters:
 Feed plane to 2.5. Sets the 

height that the tool rapids to 
before changing to the 
plunge rate to enter the part.

 Ensure that Feed plane is set 
to Incremental.

 Top of Stock to 0.0. Sets the 
top of the stock.

 Ensure that Top of stock and 
Depth are set to Absolute.

22 Click the Depth button to return to 
the graphics window.
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23 Select the arc shown below:

You will need to rotate the part with your mouse to select it.
24 You will then automatically return to the 2D High Speed Toolpath - Dynamic 

Mill dialog box.  Your Depth should be -10.16.
25 Click OK in the 2D High Speed Toolpath - Dynamic Mill dialog box to 

generate your toolpath. 
INTRODUCTION TO DYNAMIC MILLING
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26 The toolpath will display as shown below: 

You will notice that the toolpath clears out the top of the part while avoiding 
the large feature that was selected as the avoidance region. 

27 Save your part.

Exercise 5: Verify the toolpaths
You will now verify both Dynamic Mill toolpaths with Mastercam Simulator. 

1 Select Toolpath Group-1 in the 
Toolpaths Manager.
This will select both Dynamic Mill 
toolpaths.
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2 Select Verify selected operations.
Mastercam Simulator displays.

Mastercam Simulator allows you to verify your toolpaths by using solid 
models to simulate part machining against a selected stock definition. The 
result Verify creates represents the surface finish, and shows collisions, if any 
exist. Use it identify and correct program errors before they reach the shop 
floor.

3 Right-click in the graphics view and select Fit and Isometric from the menu. 
Mastercam Simulator should match the image shown below. 
INTRODUCTION TO DYNAMIC MILLING
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4 View the Move List, which displays 
all pertinent information about the 
toolpaths being verified. 
The two Dynamic Mill toolpaths are 
able to machine the part in the time 
shown with the given parameters. 

5 Press Play to preview the toolpath motion for both operations.
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6 Once you are satisfied with your results, close Mastercam Simulator.

7 Save your part file. 
The Dynamic Mill toolpaths easily and quickly remove all of the stock on the outside 
and prepares the part for any other necessary operations. In the next lesson, you will 
create a Face toolpath to further machine this part.
INTRODUCTION TO DYNAMIC MILLING
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LESSON 2
2The Face Toolpath

Face toolpaths quickly clean the stock from the top of a part and create an even 
surface for future operations. This toolpath can be based on chained geometry or on 
the current stock model. 
For this lesson, you will create a Face toolpath on the top of the part from the Dynamic 
Mill lesson. 

Lesson Goals
 Create a Face toolpath
 Preview the toolpath before it has been created
 Verify the created toolpath 

Exercise 1: Create the Face toolpath
1 Open the part file, FaceMill, provided with this tutorial or use your part file 

created from the Dynamic Mill lesson.
2 If you are using your part from the 

previous lesson, select Toggle 
display on selected operations on 
the Toolpaths Manager. 
This will hide the two Dynamic Mill 
toolpaths and keep the graphics 
view clean.

3 Save the part as FaceMill-xxx, replacing xxx with your initials.
4 Select Face from the 2D Gallery on the Mill Toolpaths contextual tab.

The Chaining dialog box displays.
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5 Select Solids to activate solid 
selection.

6 Activate Face selection.
This allows you to select the face of 
a solid.

7 Select the solid face shown below: 

8 Select OK in the Chaining dialog box. 
The 2D Toolpaths - Facing dialog box displays.
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9 Select the Tool page.

10 Select the END MILL WITH RADIUS - 20 / R 1.0, which was used in the 
previous two Dynamic Mill toolpaths. 

11 Select the Cut Parameters page.
INTRODUCTION TO DYNAMIC MILLING
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12 Set the following parameters:

 Style to Dynamic. Creates a smooth controlled motion that cuts from 
the outside to the inside, maintaining a constant load on the tool with 
minimal entries and exits.

 Stock to leave on floors to 0.0. Sets the amount of stock to leave on 
the floors during machining.

 Max. stepover to 50.0. Sets the distance between adjacent passes in 
the toolpath. 

13 Select the Linking Parameters 
page. 
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14 Set the following parameters:

 Deselect Retract. Sets the height that the tool moves up to before the 
next tool pass.

 Set Feed plane to 2.5. Sets the height that the tool rapids before 
changing to the plunge rate to enter the part. 

 Set Top of stock to 0.2. Sets the height of the material in the Z axis. 
Before clicking OK, you will first preview the toolpath. Previewing toolpaths allows you 
to view the toolpath before generating it so that you can make adjustments as neces-
sary.

15 Select Preview toolpath on the 2D 
Toolpaths - Facing dialog box. 
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The toolpath will display on the part as shown below: 

16 Click OK in the 2D Toolpaths - Facing dialog box to close and generate the 
toolpath.

17 Save your part. 

Exercise 2: Verify the toolpaths
You now verify the two Dynamic Mill toolpaths created from the previous lesson and 
the Face toolpath together. 

1 Select Toolpath Group-1 in the 
Toolpaths Manager.
This selects both Dynamic Mill 
toolpaths and the Facing toolpath.
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2 Select Verify selected operations.
Mastercam Simulator displays.

3 Right-click in the graphics view and select Fit and Isometric from the menu. 
Mastercam Simulator should match the image shown below. 

4 Press Play to preview the toolpath motion for the toolpaths.

There will be material remaining on the top face of the part. That is to be 
expected.
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5 View the Move List, which displays 
all pertinent information about the 
toolpaths being verified. The three 
Dynamic Mill toolpaths are able to 
machine the part in the time shown 
with the given parameters. 

6 Use Verify’s Color Loop option to 
help distinguish between each 
toolpath.

Mastercam Simulator color-codes each toolpath so that you can distinguish 
where each toolpath cuts the part. The colors on the part correspond to those 
on the time bar.
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7 Once you are satisfied with your results, close Mastercam Simulator.
8 Save your part file.

The Dynamic Mill toolpaths and the Face toolpath, you have quickly cleared the part 
to prepare it for finishing operations. In the next lesson, you create two Dynamic 
Contour toolpaths.
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LESSON 3
3The Dynamic Contour Toolpath

Mastercam’s Dynamic Contour toolpath mills material off walls and supports closed or 
open chains. Compared to its standard counterpart, Dynamic Contour is much more 
efficient for cutting by using the entire flute of the tool, as with all dynamic motion 
toolpaths.
In this lesson, you create a Dynamic Contour toolpath to clear around the walls of the 
part. 

Lesson Goals
 Create two Dynamic Contour toolpaths
 Analyze the toolpaths
 Verify the created toolpaths

Exercise 1: Set up the stock 
1 Open the part file, DynamicContour, provided with this tutorial.
2 Save the part as DynamicContour-xxx, replacing xxx with your initials.
3 On the Machine tab, select Mill, 

Default. 
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4 Select Stock setup from the 
Toolpaths Manager. 
The Machine Group Properties 
dialog box displays.

5 Select Bounding box on the Stock 
Setup page. 
The Bounding Box function panel 
displays.

6 Select the part and press [Enter] or select End Selection.
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7 Set Z to 13.7. This adds a small 
amount of stock to the Z height of 
the stock boundary.

8 Click OK to create the boundary. 
9 Click OK to accept the stock setup.

Exercise 2: Create the first Dynamic Contour toolpath
1 Select Dynamic Contour from the 2D Gallery on the Mill Toolpaths 

contextual tab.

The Enter new NC name dialog box displays.
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2 Click OK in the Enter new NC Name 
dialog box. You would use this 
dialog box to change the name of 
the resulting NC file from the default 
name.
The Chain Options dialog box 
displays. 

3 Click Select under Machining 
regions.
The Chaining dialog box displays. 

4 Select Solids to activate solid 
chaining mode.
In the solid chaining mode, the 
chaining dialog box gives you 
options to manage the chaining of 
solid entities.

5 Confirm that Loop is selected. 
This allows you to select a closed 
chain on a reference face.
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6 Select the edge shown below. You may need to zoom in.

The Pick Reference face dialog box displays. This dialog box allows you to 
cycle through possible reference faces on a solid until you reach the one you 
want.

7 Ensure that the face shown below is selected:

Select Other face if necessary to cycle through the possible reference faces.
8 Click OK to return to the Chaining dialog box.
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The chain will be displayed as shown below:

Reverse the chain if necessary.
9 Click OK in the Chaining dialog box to accept the chains and return to the 

Chain Options dialog box.
10 Click OK in the Chain Options dialog box.

The 2D High Speed Toolpath - Dynamic Contour dialog box displays.
11 Select the Tool page.

12 Click the Select library tool button. 
The Tool Selection dialog box displays. 
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13 Click the Filter button.
The Tool List Filter dialog box 
displays.

14 Set the Tool Type filter to None.
15 Select the Endmill1 Flat filter. This ensures that you are only selecting Flat 

Endmill tools.
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16 Click OK in the Tool List Filter dialog box. 
17 Select the FLAT END MILL - 4 tool. 

18 Click OK in the Tool Selection dialog box.
19 Select the Cut Parameters page.
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20 Set the following parameters: 

 Compensation direction to Left. Offsets the tool to the right or left of the 
toolpath.

 Approach distance to 5.0. Adds a specified absolute distance to the 
beginning of the toolpath’s first cut.

 First pass offset to 1.0. Offsets the machining region to ensure the tool 
does not engage too much material during the first pass of the toolpath 
entering stock from the outside. 

 Stepover to 15.0%. Sets the distance between cutting passes in the X and 
Y axes.

 Min toolpath radius to 5.0%. Sets the minimum toolpath radius for the 
operation.

 Set Stock to leave on walls and Stock to leave on floors to 0.0. You are 
not leaving any stock on the vertical and horizontal surfaces. 
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21 Select the Contour Wall page.

22 Set the following parameters:
 Radius of tool that shaped 

the stock to 8.0. 
 Min toolpath radius that 

shaped the stock to 1.0.
 Stock thickness to 0.025.

Both parameters help define the shape of the stock removed by the toolpath. 
Mastercam calculates the stock to remove along the contour wall by using 
these parameters.

23 Select the Linking Parameters 
page.
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24 Set the following parameters:

 Retract, Top of stock, and Depth to Absolute. This measures absolute 
values from the origin 0,0,0. 

 Retract to 15.0. Sets the height that the tool moves up before the next 
tool pass. 

 Feed plane to 3.0. Sets the height that the tool rapids to before 
changing to the plunge rate to enter the part. 

 Top of stock to 13.7. Sets the height of the material in the Z axis.
25 Click the Depth button. You return 

to the graphics window.
Depth determines the final 
machining depth and the lowest 
depth that the tool descends into 
stock. You will select an edge for this 
toolpath.
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26 Select the edge shown below: 

You automatically return to the Linking Parameters page. Your Depth should 
now be 9.525.

27 Click OK in the 2D High Speed Toolpath - Dynamic Contour dialog box to 
accept and generate your toolpath.

28 Your toolpath display as shown below: 

29 Save your part.
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Exercise 3: Create the second Dynamic Contour toolpath
1 Select Dynamic Contour from the 2D Gallery on the Mill Toolpaths 

contextual tab.

The Chain Options dialog box displays.
2 Click Select under Machining 

regions.
The Chaining dialog box displays. 

3 Activate Solid selection if necessary.
4 Set the chaining to Linked edges. 

This allows you to select contiguous 
chaining of edges. 
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5 Zoom in using the mouse wheel to the edge of the part shown below.

6 Select the edge shown below:
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7 The chain will display as shown below. Reverse the direction if needed, using 
the Reverse button on the Chaining dialog box.

8 Select along the edge until you end with the selected chain shown below.
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9 In the Chaining dialog box, click End 
chain. 
This ends the chain so that you can 
start a new one that is not linked to 
the previous chain.

10 Select the second partial chain shown below:

11 Click OK in the Chaining dialog box and return to the Chain Options dialog 
box.

12 Click OK in the Chain Options dialog box.
The 2D High Speed Toolpath - Dynamic Contour dialog box displays.

13 Select the Tool page.

14 Click the Select library tool button. 
The Tool Selection dialog box displays. 
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15 Select the FLAT END MILL - 8 tool. 

16 Click OK in the Tool Selection dialog box.
17 Select the Cut Parameters page.
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18 Set the following parameters: 

 Approach distance to 12.0.
 First pass offset to 3.0.

19 Select the Contour Wall page.

20 Set Radius of tool that shaped the 
stock to 10.0. 
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21 Select the Linking Parameters 
page.

22 Set the following parameters:

 Retract to 16.0.
 Feed plane to 3.0 and Incremental. Incremental values are relative to 

other parameters or chained geometry.
 Top of stock to 9.525.
 Depth to 0.0 and Incremental.

23 Click OK to generate the toolpath.
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The toolpath will display as shown below: 

Exercise 4: Analyze the toolpaths
You now analyze the toolpath. Analyze Toolpath allows you to view toolpath proper-
ties, such as coordinates, direction, operation number, and other information by 
hovering over the toolpath.

1 Select Analyze Toolpath from the Home tab.
INTRODUCTION TO DYNAMIC MILLING



VERIFY THE TOOLPATHS   79
2 Hover over the first toolpath:

Analyze Toolpath informs you of the operation number, the feed move, 
spindle speed, G1 and the line length, and the coolant code. It also displays 
the start and end of the toolpath and of the section you are hovering over.

3 Continue hovering over areas of both toolpaths. Once you are satisfied, press 
[Esc] or Cancel out of the function.

Exercise 5: Verify the toolpaths
You will now verify both toolpaths. 

1 Select Toolpath Group-1 in the 
Toolpaths Manager.
This selects both toolpaths so that 
they can be verified at the same 
time.
INTRODUCTION TO DYNAMIC MILLING



80  MASTERCAM 2017 / The Dynamic Contour Toolpath
2 Select Verify selected operations.
Mastercam Simulator displays.

3 Right-click in the graphics view and select Fit and Isometric, if necessary, so 
that the display matches the image below:
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4 View the Move List, which displays 
all pertinent information about the 
toolpaths being verified. 
By using two Dynamic Contour 
toolpaths, the total machining time 
is around 1 minute. 

5 Press Play to preview the toolpath motion for both operations.

6 Once you are satisfied with your results, close Mastercam Simulator.
7 Save your part file. 

In the next lesson you will create three Peel Mill toolpaths.
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LESSON 4
4The Peel Mill Toolpath

The Peel Mill toolpath, with the Cutting strategy set to Dynamic Peel, allows for effi-
cient milling between selected chains. It uses a dynamic style of motion with acceler-
ated back feed moves when the tool is not engaged in material. 
In this lesson you will create one Peel Mill toolpath, copy it twice, and make edits.

Lesson Goals
 Create a Peel Mill toolpath
 Copy and paste the toolpath
 Make edits to the copied toolpaths
 Verify the created toolpaths

Exercise 1: Create the stock boundary 
1 Open the part file, PeelMill, provided with this tutorial.
2 Save the part as PeelMill-xxx, replacing xxx with your initials.
3 On the Machine tab, select Mill, 

Default. 
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4 Select Stock setup from the 
Toolpaths Manager. 
The Machine Group Properties 
dialog box displays.

5 Select Bounding box. 
The Bounding Box function panel 
displays.

6 Select the part and press [Enter] or click End Selection.
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For this part, no geometry needs to be created. The bounding box will be 
accepted as it is.

7 Click OK to create the boundary. 
8 Click OK to accept the stock setup.

Exercise 2: Create the first Peel Mill toolpath
1 Select Peel Mill from the 2D Gallery on the Mill Toolpaths contextual tab.

The Enter new NC name dialog box displays.
2 Click OK in the Enter new NC name 

dialog box.
The Chaining dialog box displays.
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3 Activate Solids selection from the 
Chaining dialog box. 

4 Select Edge if it has not already 
been selected.
This allows you to select the solid 
edges of a model.

5 Select Translucency on the View tab. 

This toggles the translucency of the current model and will help with selection 
for this first toolpath.
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6 Select the two edges shown below. Use the Reverse button if necessary.

7 Toggle Translucency to off. 
8 Click OK in the Chaining dialog box.

The 2D High Speed Toolpath - Peel Mill dialog box displays.
9 Select the Tool page. 
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10 Click Select library tool. 
The Tool Selection dialog box 
displays.

11 Click Filter. 
The Tool List Filter dialog box 
displays.

12 Ensure that tools are filtered to Endmill1 Flat.
13 Click OK in the Tool List Filter dialog box to accept the filter and return to the 

Tool Selection dialog box.
14 Select the FLAT END MILL - 12 tool.
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15 Click OK to add that tool and exit the Tool Selection dialog box. 
16 Select the Cut Parameters page.

17 Set the following parameters:

 Stepover to 20.0%. 
 Min toolpath radius to 5.0%. 
 Select Extend Exit and set Additional exit distance to 3.0. This 

adjusts the final tool engagement with the material.
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18 Select the Linking Parameters 
page.

19 Set the following parameters:
 Set Retract to 40.0. 
 Set Feed plane to 40.0. 

20 Click Top of stock. 
This returns you to the graphics 
window to select the top of the 
stock of the part. 

21 Select the point shown below: 

You automatically return to the Linking Parameters page. Top of stock will be 
set at 38.1.
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22 Click OK in the 2D High Speed Toolpaths - Peel Mill dialog box to generate 
the toolpath. 
The toolpath will display as shown below: 

23 Save your file. 

Exercise 3: Copy the Peel Mill toolpath
In this exercise, you copy the Peel Mill operation twice in the Toolpaths Manager.

1 Right-click on the 2D High Speed (2D Dynamic Peel Mill) toolpath and drag 
and drop it below the red insert arrow. 
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2 Select Copy after from the right-click menu that displays. 

The toolpath is copied below the original. There are now two Peel Mill 
toolpaths in the Toolpaths Manager. 

3 Copy the toolpath once more. You 
will now have three Peel Mill 
toolpaths in the Toolpaths Manager.
Copying and pasting toolpaths is 
helpful when you have to do similar 
cuts on the same part. In the case of 
these toolpaths, you will have to re-
chain the geometry. 

4 Save your file.

Exercise 4: Re-chain the copied Peel Mill operations
In this exercise, you will re-chain the geometry for the second Peel Mill toolpath. 
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1 Select Geometry under the second 
Peel Mill toolpath.
The Chain Manager dialog box 
displays.

2 Right-click in the Chain Manager 
dialog box and select Rechain all.
The Chaining dialog box displays.
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3 Select the chains shown below. Ensure that the chains are both going in the 
same direction. You may need to rotate the part to select them.

By doing this, you only need to select the chains for the toolpath without 
having to go through creating the entire toolpath again.

4 Click OK in the Chaining dialog box and return to the Chain Manager dialog 
box.

5 Click OK in the Chain Manager dialog box.
Before regenerating the toolpath, you will re-chain the third operation.

 6 Select Geometry under the third 
Peel Mill toolpath.
The Chain Manager dialog box 
displays.

7 Right-click in the Chain Manager dialog box and select Rechain all.
The Chaining dialog box displays.
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8 Select the chains shown below. Ensure that the chains are both going in the 
same direction.

9 Click OK in the Chaining dialog box and return to the Chain Manager dialog 
box.

10 Click OK in the Chain Manager dialog box.
11 Select Regenerate all dirty 

operations in the Toolpaths 
Manager.
The second and third Peel Mill 
toolpaths regenerate using the 
newly selected chains.
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12 All three Peel Mill toolpaths will display as shown below: 

13 Save your file.

Exercise 5: Verify the toolpaths
Now you verify all three Peel Mill operations together. 

1 Select Toolpath Group-1 in the Toolpaths Manager to select all of the 
toolpaths.

2 Select Verify selected operations.
Mastercam Simulator displays.
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3 Right-click in the graphics view and select Fit and Isometric, if necessary, so 
that the display matches the image below:

4 View the Move List to view the total 
runtime of the toolpaths.
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5 Press Play to preview the toolpath motion for the operations.

6 Once you are satisfied with your results, close Mastercam Simulator.
7 Save your part file. 

When creating similar toolpaths, copying and pasting save time. In the next lesson you 
create two Dynamic OptiRough operations and a stock model operation.
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5The Dynamic OptiRough Toolpath

The 3D surface high speed Dynamic OptiRough toolpath uses an aggressive, fast, 
intelligent roughing algorithm based on Mastercam’s 2D high speed dynamic milling 
motion. 
In this lesson, you will create two Dynamic OptiRough toolpaths using different 
cutting strategies and a stock model operation in order to rough out the part. 

Lesson Goals
 Set up the stock
 Create two Dynamic OptiRough toolpaths
 Create a stock model operation

Exercise 1: Set up the stock 
In this exercise, you will create the stock model that will be used for the first Dynamic 
OptiRough toolpath.

1 Open the part file, DynamicOptiRough, provided with this tutorial.
2 Save the part as DynamicOptiRough-xxx, replacing xxx with your initials.
3 On the Machine tab, select Mill, 

Default. 

4 Select the Levels Manager, located in the same area as the Toolpaths 
Manager. If it is not displayed, select Levels from the View tab to toggle the 
display. 
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Before creating the stock shape, you will first create a level to place the stock 
geometry on. This is a good practice for when you have part files that have 
thousands of lines, arcs, solids, or surfaces and you need to keep things 
separate from each other. 

5 On the Levels Manager, select the 
Add a new level button. 
A new level is added to the list and is 
then set as the main level.

6 Double-click in the Name column of 
the level you have just created and 
rename it to Stock geometry.
This level will now be used to place 
the geometry created by the stock 
setup. 

7 Select Stock setup from the 
Toolpaths Manager. 
The Machine Group Properties 
dialog box displays.

8 Select Bounding box. 
The Bounding Box function panel 
displays.
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9 Window select all entities to create a bounding box around the entire part:

10 Press [Enter] to accept your selection. 
11 Set the Shape to Cylindrical. 
12 In the Cylindrical Settings group, set 

the following parameters:
 Set the Axis to Z.
 Set the Height to 102.00. 

This will add a small amount 
of stock at the top of the part.

13 In the Create Geometry group, select 
the Lines and arcs checkbox.
This will create lines and arcs based 
on the stock boundary. You will then 
use this geometry to contain the first 
Dynamic OptiRough toolpath.
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14 Click OK to create the boundary. 
15 Click OK to in the Machine Group Properties dialog box to accept the stock 

setup.
The stock model displays as a dashed outline in red. The geometry that was 
created with the Bounding Box also displays. 

Exercise 2: Create the first toolpath
In this exercise, you create the first Dynamic OptiRough toolpath that uses this stock 
boundary. 

1 Select OptiRough from the 3D Gallery on the Mill Toolpaths contextual tab.

The Enter new NC name dialog box displays.
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2 Click OK in the Enter new NC name 
dialog box.
You then select the drive surfaces for 
the toolpath.

3 Select the part body as the drive surfaces, as shown below.This includes the 
blue caps.

4 Press [Enter] or click End Selection to accept these surfaces. 
The Toolpath/surface selection dialog box displays.
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5 Click the Select button in the 
Containment group. 
This returns you to the graphics 
window to select one or more closed 
chains of curves to limit the tool 
motion.

6 In the graphics window, select the geometry at the top of the stock boundary. 
You will need to change back to Wireframe mode in the Chaining dialog box.

7 Click OK to return to the Toolpath/surface selection dialog box.
8 Click OK in the Toolpath/surface selection dialog box. 
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The Surface High Speed Toolpaths - Dynamic OptiRough dialog box displays.
9 On the Toolpath Type page, ensure 

that the Containment boundary is 
set to From Outside. 
From Outside sets the toolpath to 
machine from outside the 
containment boundary moving in. 
This strategy is best used for 
machining cores. 

10 Select the Tool page. 

11 Click the Select library tool button. 
The Tool Selection dialog box displays. 

12 Select the Filter button.
The Tool List Filter dialog box 
displays.
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13 Set the Tool Type filter to None.
14 Select the Endmill3 Bull filter. This ensures that you are only selecting Bull 

Endmill tools.
15 Click OK in the Tool List Filter dialog box. 

You return to the Tool Selection dialog box.
16 In the Tool Selection dialog box, select the END MILL WITH RADIUS - 20/

R2.0 tool. 

17 Click OK in the Tool Selection dialog box to add the tool to the toolpath.
18 Select the Cut Parameters page.
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19 Set the following parameters:

 Optimize stepups to By pocket. Mastercam first machines all 
stepdowns, moving from pocket to pocket. After all stepdowns on a z-
level are machined to completion, Mastercam machines the stepups by 
next closest, in the safest cut order. 

 Stepover to 30.0%. Sets the distance between cutting passes in the X 
and Y axes. 

 Stepdown to 150.0%. Determines the Z spacing between adjacent 
cutting passes.

 Select the Stepup checkbox and enter 15.0. Mastercam calculates and 
adds step up cutting passes (+Z) to the toolpath.

 Minimum toolpath radius to 10.0. Sets the minimum toolpath radius 
to create in the operation. 

 Micro lift distance to 0.0. 
 Back feed rate to 100.0. Controls the speed of the backfeed 

movement of the tool. 
 % of tool diameter to 10000.0. 
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20 Select the Transitions page.

21 Set the following parameters:

 Set Helix radius to 9.0. Sets the radius of the entry helix. 
 Set Skip pockets smaller than to 13.2. Specifies a minimum pocket 

size that Mastercam will create a cutting pass for. This helps with 
problems where Mastercam thinks that a pocket is large enough to 
accommodate the tool, but the entry move is so compressed the tool is 
effectively plunging into the part. 

22 Select the Linking Parameters 
page. 
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23 Set the following parameters:

 Set the Retract Method drop-down to Minimum Distance. Creates 
high speed loops into and out of each retract move.

 Check Output feed move and enter 12500.0. Outputs the rapid move 
between passes as a feed rate move instead of a rapid move. This helps 
when the tool needs to make many irregular moves per pass to jump 
between different areas of the part. 

 Set Ramp height to 1.0. Sets the height of the helix when moving into 
a new region.

24 Click OK to close the Surface High Speed Toolpaths - Dynamic OptiRough 
dialog box and generate your toolpath. 
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25 Your toolpath should display as follows: 

26 Save your part file.

Exercise 3: Create the stock model operation
You now create a stock model operation that uses the previous operation as its 
source. This stock model will be used in the second Dynamic OptiRough toolpath to 
clear out any remaining stock. 

1 On the Toolpaths Manager, select 
Only display selected toolpaths.
This will only display the toolpath 
you have selected. It will also clean 
up the graphics view when making 
modifications to the part or creating 
another toolpath.
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2 Select Stock Model on the Mill Toolpaths contextual tab.

The Stock model dialog box displays.
3 Name the stock operation OP1 

Stock.
Naming your stock model based on 
which operation it is using is helpful, 
especially when you have a part with 
multiple stock model operations.

4 Set Color to 128. 
This will help differentiate the stock 
model from the solid or surface 
model.

5 Select the Bounding box button. 
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The Bounding box function panel displays.
6 Select the part body, including the caps. Do not select the stock geometry 

made creating the previous stock model. If necessary, turn off the Stock 
geometry level.

7 Press [Enter] or click End Selection to accept the selection. 
The Bounding Box function panel displays.

8 Set the following parameters:
 Shape to Cylindrical
 Height to 102.00.
 Axis to Z. 

9 Click OK to accept the stock model and return to the Stock model dialog box.
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10 Select the Source Operations page. 

11 Select the Surface High Speed (Dynamic OptiRough) toolpath as the 
source operation. 

The stock model is generated by running the selected operation against the 
parameters on the Stock Definition page.

12 Click OK to create the stock model operation.
13 Your stock model displays as shown below: 
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This may take some time to calculate. 
14 Save your part.

Exercise 4: Create the second toolpath
You now create the second Dynamic OptiRough toolpath that uses the stock model 
you created in the previous exercise.

1 Select Toolpath Group-1 in the Toolpaths Manager.
2 Select Toggle display on selected 

operations. This hides all selected 
toolpaths to keep the graphics 
window clean.

3 Select OptiRough from the 3D Gallery on the Mill Toolpaths contextual tab.

You then select the drive surfaces for the toolpath.
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4 Select all but the blue caps as the drive surfaces shown below.

5 Press [Enter] or click End Selection to accept these surfaces. 
The Toolpath/surface selection dialog box displays.

6 Click the Select button in the 
Containment group. 
This returns you to the graphics 
window to select one or more closed 
chains of curves to limit the tool 
motion.
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7 In the graphics window, select the geometry at the top of the stock boundary.

8 Click OK to return to the Toolpath/surface selection dialog box.
9 Click OK in the Toolpath/surface selection dialog box. 

The Surface High Speed Toolpaths - Dynamic OptiRough dialog box displays.

10 Select the Tool page. 

11 Click the Select library tool button. 
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12 In the Tool Selection dialog box, select the END MILL WITH RADIUS - 10/
R1.0 tool. 

13 Click OK to add the tool to the toolpath.
14 Select the Stock page.

15 Select the Rest material checkbox.

When you enable this page, Mastercam calculates the cutting passes based 
on the remaining stock.
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16 Set the following parameters: 

 Set Compute remaining stock from to One other operation.
 In the Operation List, select Stock Model - OP1 Stock. 
 Set Adjustments to remaining stock to Ignore small cusps. 
 Set Distance to 1.0. This option is used in conjunction with Ignore 

small cusps. Mastercam will output cuts that engage large amounts of 
material.

17 Select the Cut Parameters page.
INTRODUCTION TO DYNAMIC MILLING



CREATE THE SECOND TOOLPATH   119
18 Set the following parameters:

 Optimize stepups to Next closest. Mastercam moves to the closest 
cut from its last position on the previous cut.

 Stepover to 30.0%.
 Stepdown to 150.0%.
 Stepup to 30.0%.
 Minimum toolpath radius to 10.0%. 
 Motion > Gap size, retract to When avoiding a boundary. Adds 

retracts to avoid intersecting boundaries (a gouge boundary, or a 
boundary of material yet to be milled). 

19 Select the Tool containment page.
This page controls the tool’s 
position around the boundary of 
your part.
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20 Set the following parameters:

 Set Compensate to to Outside. Sets the outer edge of the tool to be 
bound to the containment boundary.

 Set Offset distance to 10.0. This option adjusts the inside or outside 
tool containment boundary.

21 Select the Transitions page.

22 Set the Helix radius to 5.5.
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23 Click OK to create and generate the Dynamic OptiRough toolpath.
24 Your toolpath will display as shown below: 

25 Save your part file.

Exercise 5: Verify the stock model and toolpaths
In this exercise, you use Mastercam Simulator to verify your toolpaths and stock 
model. Verifying your toolpaths allows you to use solid models to simulate part 
machining against the selected stock definition.
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1 Select Toolpath Group-1 in the 
Toolpaths Manager.

2 Select Verify selected operations in 
the Toolpaths Manager.
Mastercam Simulator displays.
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3 If necessary, right-click in the graphics window and change the view to 
Isometric and Fit the part to the screen so that it matches the image shown 
below.

4 Click the Play button or press [R] to verify the toolpaths.
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5 View the Move List to view the total 
runtime of the toolpaths.

6 Once you are satisfied with the verification, close Mastercam Simulator.
7 Save your part.
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Conclusion

Congratulations! You have completed the Introduction to Dynamic Milling tutorial. 
Now that you have mastered the skills in this tutorial, explore Mastercam’s other 
features and functions. 
You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. Visit our 
website, or select Help, Tutorials from the File tab to see the latest publications.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

 Mastercam Help—Access Mastercam Help by selecting Help, Contents from 
Mastercam’s File tab or by pressing [Alt+H] on your keyboard. Also, most 
dialog boxes, function panels, and ribbon bars feature a Help button that 
opens Mastercam Help directly to related information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.

 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. Visit our website, or select Tutorials from the Help menu to 
see the latest publications.

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 

mailto:support@mastercam.com
http://www.mastercamu.com
mailto:training@mastercam.com
http://www.mastercam.com
http://www.facebook.com/mastercam
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Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 
To register, select Community, Link Account from the File tab, and follow 
the instructions.

Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide
 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.
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671 Old Post Road
Tolland, CT 06084 USA
www.mastercam.com

Attention! Updates may be available. 
Go to Mastercam.com/Support for the latest downloads.
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